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Searching   

How to Perform a Basic Spectral Search 

 
Purpose 
 
These exercises demonstrate how to perform spectral searches using KnowItAll.  
 

Objectives 

 
These exercises will teach you: 

➢ How to select databases for searching 

➢ How to configure and perform various spectral searches 

 

Background 

 
Spectral searching against reference databases is frequently used in both the analysis of unknown 
compounds and in compound verification. KnowItAll SearchIt application facilitates this purpose. 

 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples 
folder 

• Acetic anhydride.dx 

• Multi-Technique Sadtler Demo Database - 
Wiley [DEMO].sdbx 

KnowItAll Applications Used 

• SearchIt  

• MineIt  
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KnowItAll IR and Raman Search Algorithms 

A background in the algorithms used by KnowItAll will be beneficial. For IR and Raman spectral comparison, KnowItAll uses the following algorithms: 
 
Correlation 

This is the default algorithm for searching in KnowItAll and it conforms to the industry standard for correlation algorithms. The Correlation algorithm 
is similar to the Euclidean Distance algorithm. The difference between the two is in the way the spectra are treated before the comparison. Each 
spectrum is mean centered prior to performing the dot product normalization. This approach can improve search results for noisy spectra and spectra 
that have baseline issues, particularly with a baseline offset that is the result of a negative spike or chemical noise. It is slightly more time-consuming 
than the Euclidean Distance algorithm. The search speed is slower because each spectrum in the database must be mean centered and then 
normalized prior to the comparison. The search results that are obtained with the Correlation algorithm are spectrally similar to the unknown, even 
if the unknown compound is not in the database. The Correlation algorithm is heavily weighted by peak areas. Broad features are weighted much 
more strongly than sharp features. The algorithm is most tolerant to peak shifts and non-linearities in relative band intensities. 

Correlation (Classic) 

The Correlation algorithm that was found in all versions of KnowItAll prior to KnowItAll 2020 is similar to the Euclidean Distance algorithm.  However, 
it did not conform to the industry standard for correlation algorithms. Beginning with KnowItAll 2020, the Correlation algorithm does conform to the 
industry standard and it is the default algorithm used for searching in KnowItAll. To provide backward compatibility for customers who want to 
reproduce prior search results, the previous correlation algorithm is now provided as Correlation (Classic). 

Euclidean Distance  

The Euclidean Distance algorithm measures the point-to-point differences between a pair of spectra. The results that are obtained with the Euclidean 
Distance algorithm are spectrally similar to the unknown, even if the unknown compound is not in the database. This algorithm, however, can 
yield degraded search results when the unknown spectrum has a sloping or offset baseline. The Euclidean Distance algorithm is heavily weighted 
by peak areas. Broad features are weighted much more strongly than sharp features. This algorithm is most tolerant to peak shifts and non-linearities 
in relative band intensities. 

First Derivative Euclidean Distance  

Use this algorithm to reduce the effects of baseline slope or offset in the unknown. Although search speed is slightly slower than with the Euclidean 
Distance algorithm, the First Derivative Euclidean Distance sometimes gives improved search results, especially when the unknown spectrum is a 
mixture of two or more compounds. The First Derivative Euclidean Distance algorithm is heavily weighted by changes in slope. Sharp features are 
weighted much more strongly than broad features. The algorithm is also very sensitive to peak shifts. Small shifts can make the algorithm miss a 
similar result. 

Second Derivative Euclidean Distance Use the Second Derivative Euclidean Distance algorithm to compare the second derivative of a reference 
spectrum to that of the query spectrum. 

http://help.knowitall.com/mergedProjects/SearchIt/Linked_Topics/Algorithms/algorithm_Euclidean_Distance.htm
http://help.knowitall.com/mergedProjects/SearchIt/Linked_Topics/Optimized_Corrections/algorithm_Euclidean_Distance.htm
http://help.knowitall.com/mergedProjects/SearchIt/Linked_Topics/Optimized_Corrections/algorithm_correlation.htm
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Optimized Corrections: A Breakthrough Technology for Spectral Searching 

Spectral searching is one of the most important tools researchers use to classify or identify materials, yet it continues to be plagued by errors and 
imperfections. During a spectral search, a sample spectrum is compared to a database of reference spectra. To ensure that an optimal match is 
found in the database, spectra can be adjusted to compensate for differences between spectra caused by variability in instruments, accessories, 
environmental conditions, and other factors. 
 
According to ASTM's guide on spectral searching1, various algorithms and manual methods exist to adjust spectra to get reasonable match scores 
when two compared spectra of the same compound differ for various reasons. While these methods may work in selected cases, subtle discrepancies 
such as a shift of the X-axis are very hard to identify and correct manually. The inflexible mathematical algorithms typically employed do not 
compensate for these types of errors in spectra that are flawed.  
 
Manual corrections can be made by expert spectroscopists, but those less experienced in spectroscopy are often unaware of how to perform the 
necessary corrections on their sample spectrum to achieve the best search result. To address this growing concern, Wiley has introduced Optimized 
Corrections, a breakthrough patented technology that performs a computationally complex set of multiple corrections on query and reference spectra 
in a search to find the optimal match between the query and each individual reference spectrum. This training guide will demonstrate how the 
Optimized Corrections technology yields better matches between query and reference spectra than can be attained using rigid search algorithms 
alone or with manual methods to optimize spectra for searching. 
 
Optimized Corrections consider the full spectrum during a selected range(s) search. 
 
1 E2310-04 - Standard Guide for Use of Spectral Searching by Curve Matching Algorithms with Data Recorded Using Mid-Infrared Spectroscopy, 
2009. ASTM International Web Site. http://www.astm.org/Standards/E2310.htm (accessed March 4, 2015). 
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Create a new search and select reference databases 

 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

If the SearchIt application is already open, 
click the Close button  (located in the 
upper right corner) to close the current 
search. 

 
 
 
 
 

The SearchIt application is displayed, with the last used databases in the Selected for Searching window: 

 

2  Click on User-Select under Search 
Databases. 

This option allows users to select the databases they want to search. Users can also include user-created 
databases in a search. 

3  If a list of databases already appears in the 
Selected for Searching pane at the 
bottom, click Remove All to clear this list. 

 
 
 
 
 
 
 
 

The User category is shown below: 
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4  To the left of the Available for Searching 
window, expand each branch in the tree 
structure to display a particular database 
category—Reference, User, Hit List— and 
specify whether network, local, or all 
databases are displayed. The available 
databases are displayed at the right of the 
window.  

 

The Reference category is shown below. The database Name, number of Records, Location and version are 
displayed for each database. 

 

NOTE: Your display may look different depending on whether or not you have access to databases available 
online. 

Click Advanced on the top right to open the Advanced Options dialog box, where you can control how you 
access online databases and add or remove local database locations. Click Refresh to update the display after 
settings are changed. 

5  Click Select by Browsing button located at 
the lower left.  

The Browse for a Database or Hit List dialog box opens.  

 

6  Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples”. 

Open Multi-Technique Sadtler Demo 
Database - Wiley (DEMO).sdbx. 

The database is displayed in the Selected for Searching list.  
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7  If necessary, uncheck the All Hits check 
box and set Hit List Size Limit to 50. 

 

NOTE: When performing a spectral or peak 
search using more than two or three 
databases, it is better to limit the number of 
hits. Checking All Hits or using a larger 
value can drastically reduce the search 
speed. 

The Hit List Size Limit is equal to 50: 

 

 

Open the spectral file 

 

 Action Result 

1  Click the Spectrum button under Search 
Categories. 

Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples\IR”.  

Select Acetic anhydride.jdx.  

Click Open. 

Note: You can use the Files of Type filter 
to limit the display to specific types of files, 
such as JCAMP (*.dx, *.jdx), or to display 
all files (*.*).  

An Open dialog box appears. The spectrum is recognized as an IR spectrum and displayed in the spectral 
pane in the Spectrum tab:  

 
NOTE: You can use the checkbox at the bottom to “Apply Baseline Correction to  Query Spectrum”, if desired. 
However, KnowItAll automatically corrects the baseline. 
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Fine-tune before searching 

 Action Result 

1   Click Manually Edit Mask Ranges. 

 

NOTE: You can also click and drag in the 
Spectral pane’s Exclude Range Bar 
and Include Range Bar after closing the 
Spectral Include/Exclude Masks 
window. 

The Spectral Include/Exclude Masks dialog box opens: 

 

2  Deselect the Use full range checkbox 
under the list of Spectral Exclude 
Mask(s). Select some to see how they 
work. 

Note: The use of these masks will be 
demonstrated later in this lesson: 

The list of pre-defined Exclude Masks becomes available: 
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 Action Result 

3  Reselect the Use full range checkbox 
under the list of Spectral Exclude 
Mask(s). 

Any selected Spectral Exclude Masks are removed from the spectrum: 

 

4  Click OK to close the Spectral 
Include/Exclude Masks dialog box. 

The Spectral Include/Exclude Masks dialog box is closed. 

5  Click Edit Spectrum at the bottom right of 
the spectral pane.  

The spectrum is transferred to the popped-up ProcessIt application, where you can correct potential searching 
problems and save the corrected spectrum into the SearchIt spectrum pane. 

 

6  Click Cancel. The spectrum is returned to the SearchIt application. Changes made in the ProcessIt application are not 
saved.  
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 Action Result 

7  Click Search and MineIt will open 

In MineIt click to choose Stack Spectra 

view: 

 

 

The search results are automatically displayed in the MineIt application as a hit list, sorted by HQI. Both the 
unknown spectrum and the selected database spectrum are displayed.  

 
The HQI value measures how close the reference spectrum is to that of the query. The default scale of HQI is 
0-100. 

8  Note: The HQI (Hit Quality Index) is 
displayed for each search result, which has 
settings under: File > Preferences > Hit 
List. Click Cancel to close the dialog. 

 

The Advanced Settings dialog is launched: 
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 Action Result 

9  TIPS • You can tag individual hits in the hit list as either "Accept," "Tentative" or "Reject" using the Hit List > Tag 
As menu option or by double-clicking in the Tag column. You can then sort the hit list based on your tags.  

• You can edit which columns in the hit list are displayed by right-clicking in the data table at the bottom left, 
selecting the Edit Columns... option, and selecting which columns you would like to display as well as the 
order in which they are displayed. 

10  From the Edit menu, select Copy Active 
Spectrum. Then open an MS Office tool 
(PowerPoint, for example). Right-click on 
the screen and select Paste. 

KnowItAll objects such as the spectral pane can be copied and embedded into MS tools. 

 

11  Double-click the object in PowerPoint. KnowItAll spectrum manipulation toolbar is shown in PowerPoint. For example, you can turn on peak 
labeling. 
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 Action Result 

12  In KnowItAll, click the Back button 
(located below the File menu). 

 

You are returned to the SearchIt application, where a Summary tab has been added to the main SearchIt 
window:  

 

13  Click the KnowItAll Next Application 
button. 

 

You are returned to MineIt and the hit list.  

 

 
 
Note: one can view the metadata of query spectrum by 
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• In SearchIt, click View > Query Spectrum Info    
 
 
 
 
 
 
 
 
 
 
 

• In a MineIt hit list, click View > Windows/Tables > Query Spectrum Info. 
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Raman-specific fine-tuning before searching 

Example 1 – Cosmic Ray Correction 

 Action Result 

1 Start ProcessIt application 

 
Click Open Spectroscopy Data File 

 
Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples\Ra
man”.  

Select Co and Fe complexes on porous 
substrate.wdf.  

Click Open. 

 

The spectrum will be displayed and the Baseline Correction popup window will appear with the 
baseline options.  

 

 

Note:  Depending on user/instrument setup, Raman X-axis could be low (left) to high (right) or vice versa.  

One can flip by using a button in the toolbar:   
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 Action Result 

2 Select Cosmic Ray Removal from the 
Process menu 
 

 

3 Select for Single Spectrum 

 

Note:  One can apply Cosmic Ray 
correction to multiple Raman spectra 
opened in ProcessIt. 

The cosmic ray is marked by a down arrow:  



  

108658-2REV20241009 Copyright ©2024 by John Wiley & Sons, Inc. All rights reserved.  

KnowItAll Training   Searching IR and Raman - 16 

 Action Result 

   

4 Hit the Replace button. 
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Example 2 – Fluorescence Correction 

 Action Result 

1 One can just continue with the cosmic ray 
correction result in the previous sample, 
or open a sample with strong 
fluorescence by using Click Open 

Spectroscopy Data File 

 

In this case, we will continue from 
previous example. 

 

Process > Baseline Correction and 
Replace button 
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 Action Result 

2 Select Cosmic Ray Removal using the 
Process menu item  
 
You may preview the various Baseline 
Correction techniques. You will find that 
Fluorescence Correction does the best 
job. 
 
Hit the Replace button. 

 

 

Processed spectrum will be ready for downstream searching.  

 



  

108658-2REV20241009 Copyright ©2024 by John Wiley & Sons, Inc. All rights reserved.  

KnowItAll Training   Searching IR and Raman - 19 

Searching   

How to Create Search Profiles and Use the MineIt profile to display results 

 
Purpose 
 
This exercise demonstrates how to use search profiles and use the MineIt profile to display search results. 

 

Objectives 

 
This exercise will teach you: 

➢ How to apply a search profile 

➢ How to create a search profile 

 

Background 

 
Search Profiles are pre-defined combinations of search parameters such as Databases and Hit List 
Size Limit that can be stored for later use. Using search profiles makes searching easier, especially 
when the same type of search is repeated.  

MineIt profiles are preferences of hit list information display, it is defined in MineIt.  It can be tied to 
a search. 

 

Training Files Used in This Lesson 

KnowItAll Applications Used 

• SearchIt 
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Apply a pre-defined search profile 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already open, 
click the SearchIt Close button  to close 
the current search. 

The SearchIt application’s User-Select tab is displayed, and the Selected for Searching list displays the 
databases last used:   

 

2  If databases are already selected for 
searching, click Remove All to clear the 
selections. You can also double-click 
individual entries to remove them from the list.  

The Selected for Searching databases section is cleared: 

 

3  If necessary, choose View > Profile Toolbar 
to display Search Profiles tools. 
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 Action Result 

4  Select the IR_Polymers profile using the 
Search Profiles dropdown menu. 

Polymer databases are displayed in the Selected for Searching list:   
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Create a new search profile 

 Action Result 

1  Click the SearchIt Close button , then click 
Remove All to clear the contents of the 
Selected for Searching list. 

The User-Select tab is displayed. The Selected for Searching list is empty: 

 

2  
Click the Add a New Profile button  on the 
Profile toolbar. 

The New Profile dialog box opens. 

 

3  Type in the name of the new profile 
[IR_Polymers_2].  

 

Click OK.  

The new profile name is displayed in the Search Profiles text box: 

 

4  Specify IR in the Limit to spectral technique 
drop-down list. 

Only databases with IR spectra are displayed in the Available for Searching list. Note that Multi-
Technique Sadtler Demo Database - Wiley is included in the list because it includes IR spectra. 
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 Action Result 

5  In the Available for Searching list, click to 
select IR – Sadtler Polymers, Hummel – 
Wiley (DB Code HUX). Click Add. 

The HUX database is added to the Selected for Searching list: 

  

6  In the Available for Searching list, double-
click IR –– Sadtler Polymers & Monomers 
(Basic) 1 –– Wiley (DB Code BPX). 

The BPX database is added to the Selected for Searching list: 
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 Action Result 

7  Continue adding databases BMX, CRX, DAX, 
FRX and NEX. 

The selected databases are added to the Selected for Searching window: 

 

8  On the User-Select tab, change the Hit List 
Size Limit to 10.   

9  
Click the Save Current Profile button  on 
the Profile toolbar. A message box asks if you 
wish to overwrite the current profile. Click Yes 
to save the new profile. 

 

10  Close the current search by clicking X, then 
select the newly created IR_Polymers_2 
search profile.  

The databases and search settings associated with this profile are displayed: 
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Use MineIt profile for hit list display 

New in the KnowItAll 2024 release, one can specify how a search hit list is to be displayed in SearchIt simply by expanding the highlighted drop 
list: 
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Searching   

How to Search a Database of Spectra by Peak 

 
Purpose 
 
This exercise demonstrates how to perform a peak search. 

 

Objectives 

 
This exercise will teach you: 

➢ How to configure a peak search  
 

Background 

 
The SearchIt application provides the capability of using peak information to perform a search of 
spectral or chromatographic data. This allows users to compare peak tables from databases to a 
peak table that you enter or extract from a spectrum. 

 

 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\IR 

• Ethyl acrylate.dx 

KnowItAll Applications Used 

• SearchIt 

• MineIt 
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Configure and perform a peak search 

 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

If the application is already open, click the 
Close button  to close the current search. 

The SearchIt application’s User-Select tab is displayed, and the Selected for Searching list displays the 
databases last used: 
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 Action Result 

2  If databases are already selected for 
searching, click Remove All to clear the 
selections. Set Limit to spectral technique to 
IR. Click Add All.  

The Wiley IR database library has been added to the Selected for Searching window: 

 

3  Under Search Categories click Peaks. 
Choose IR in the pop-up dialog.  

The Spectral Technique Selection dialog appears, and user selects option for IR: 
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 Action Result 

4  Click OK. The Peaks FTIR search dialog is displayed: 
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 Action Result 

5  Click Open Spectrum File button located 
toward the bottom 

Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples\IR”. 

Open Ethyl acetate.jdx. 

The selected spectrum is displayed: 

 

  



  

108658-2REV20241009 Copyright ©2024 by John Wiley & Sons, Inc. All rights reserved.  

KnowItAll Training   Searching IR and Raman - 31 

 Action Result 

6  Click Pick. The peak table is created based on the current settings: 

 

 

7  TIP You can remove a peak from the peak table by selecting the peak and clicking the delete button or by 
double-clicking it in the peak bar. Similarly, you can add or edit peaks using the corresponding buttons at 
the bottom of the table.  
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 Action Result 

8  Click Search. In MineIt, click Overlay Spectra 
view. 

 

Search results are automatically displayed in the MineIt application:  

 
For each entry, the Spectral pane displays the hit list spectrum along with the peaks used to perform the 
search. 
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Searching   

How to Search Spectral Databases Using a Limited Range in a Spectrum 

 
Purpose 
 
This exercise demonstrates how to search spectral databases using a limited spectral range with the KnowItAll Informatics System’s SearchIt application.  
 

Objectives 

 
This exercise will teach you: 

➢ How to use the Include Range bar when configuring a spectral search 

➢ How to use the Search Masks dialog box when configuring a spectral search  

 

Background 

 
Using a limited range spectral search is slightly faster because fewer points are needed for 
computation. Using a limited range also focuses a spectral search on feature-rich areas such as 
the fingerprint region in the IR below 1500 wavenumbers and can be used in place of spectral 
subtraction by ignoring regions where impurities have peaks. 

 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\IR 

• Acetonitrile.jdx  

KnowItAll Applications Used 

• SearchIt  

• MineIt 
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Configure a spectral search 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already open, 
click the SearchIt Close button  to close 
the current search. 

The SearchIt application’s User-Select tab is displayed and the Selected for Searching list displays the 
databases last used: 

 

2  If databases are already selected for 
searching, click Remove All to clear the 
selections.  

The Selected for Searching window is cleared: 
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 Action Result 

3  In the Available for Searching Dialog, 
choose IR for Limit Spectral Technique to. 
Click Add All. 

The Wiley IR database collection is displayed in the Selected for Searching list: 

 

4  Click Spectrum under Search Categories. An Open dialog box appears. 
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 Action Result 

5  Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples\IR”. 
Open Acetonitrile.jdx. 

Note: You can use the Files of Type filter to 
display JCAMP files (or all files). 

The spectrum is displayed. 

 

6  Click, drag, and release within the Include 
Range Bar to define an Include region. 

The Include region is green in the Include Range Bar; the included spectral region has a white 
background. Spectral regions that will not be included in the search have a gray background:  

 

Using the Include Range feature allows you to set one or more ranges to be included in a spectral search. 
This feature is primarily used on a per search basis. Although the ranges set using this method will be 
remembered until they are changed, the ranges are not permanently saved. 
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 Action Result 

7  Click and drag to define a second Include 
region. 

 

Note: To move a region horizontally, click 
within the region on the Include Range Bar 
and drag to a new location. 

A second region is selected on the spectrum: 

 

8  TIPS: To re-size a region, move the cursor into the Include Range Bar and position the cursor over an endpoint, 
then drag and release. The cursor changes to a cross with a double arrowhead. 

 

 

To remove a single region, either click within the region on the Include Range Bar and drag to either side 
away from the spectral pane, or right-click within the region and choose Yes on the message box that opens.  

 

To remove all regions, click the trash can icon at the right end of the Include Range Bar.  
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Use the Search Masks dialog box 

 Action Result 

1  Clear the previous search range by clicking 
the trash can icon on the right side of the 
INCLUDE RANGE BAR  

 
Click Manually Edit Mask Ranges. Unclick 
Use full range and click Add under Spectral 
Include Mask(s) 

 

Note: Any Include regions defined using the 
Include Range Bar are displayed in the list of 
Spectral Include Mask(s). However, if Use 
full range is checked, these regions will not 
be used. 

The Spectral Include/Exclude Masks dialog box opens.  

 

2  Click to select the High Range value in the 
remaining Include region and type in ‘1750.’ 

1750 is added as a High Range value: 
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 Action Result 

3  Click to select the Low Range value in the 
remaining Include region and type in ‘500.’ 

500 is added as a Low Range value: 

 

4  Click Add to create another Include region. 
Type ‘3300 in the new High Range text box, 
then click in the Low Range column and type 
‘2700.’ 

The ranges are added to the Spectral Include Masks: 
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 Action Result 

5 Click OK.  The dialog box closes, and the search spectrum is displayed with the re-defined Include regions. 

 

6 Click Search. The search is performed, and results are automatically displayed in the MineIt application as a hit list. 

  

Clicking on the information icon  in the results table displays Optimized Corrections that have been 
performed. 
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 Action Result 

7 Close the Optimized Corrections window, 
then use the KnowItAll Back button to return to 
the SearchIt application.  

 

Click Advanced Settings on the Spectrum 
FTIR tab. 

The Advanced Settings dialog box opens: 

 
The Advanced Settings dialog can be used to control the applied Optimized Corrections. 
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Searching   

How to Search Spectral Databases Using a Mask to Exclude Regions in Your Search 

 
Purpose 
 
This exercise demonstrates how to create masks to exclude regions in a spectral search.  
 

Objectives 

 
This exercise will teach you: 

➢ How to create and use Exclude Masks when configuring a spectral search  
 

Background 

 
Exclude Masks allows you to ignore regions during spectral searching and can be defined for a 
variety of compounds such as solvents or impurities. Such masking allows for an easy method to 
remove these regions from consideration during a search. 

Unlike Include Regions, which is not permanent, Exclude Masks can be saved and re-used. 

 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\IR 

• Acetonitrile.jdx  

KnowItAll Applications Used 

• SearchIt  

• MineIt 
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Configure a spectral search 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already open, 
click the SearchIt Close button  to close 
the current search. 

The SearchIt application’s User-Select tab is displayed and the Selected for Searching list displays the 
databases last used: 

 

2  If databases are already selected for 
searching, click Remove All to clear the 
selections.  

The Selected for Searching window is cleared: 
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 Action Result 

3  Select IR using the Limit to spectral 
technique control. Click Add All. 

The Wiley IR database collection is displayed in the Selected for Searching list: 

 

Note: Many of the databases have only IR spectra, but others–such as the Multi-Technique Sadtler Demo 
Database - Wiley–include other types of spectra and structures. 

4  Click Spectrum under Search Categories. An Open dialog box appears. 

5  Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples\IR”. Open 
Acetonitrile.jdx. 

NOTE: You can use the Files of type filter to 
display JCAMP files (or all files). 

The spectrum is displayed in the IR Spectrum tab: 
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Use the Search Masks dialog box 

 Action Result 

1  Click Manually Edit Mask Ranges. The Spectral Include/Exclude Masks dialog box opens.  

 

2  Uncheck Use full range under the list of 
Spectral Exclude Mask(s), then click to select 
the Nujol mull exclude mask. 

Excluded regions are highlighted in bright red on the Exclude Range Bar, and in gray in the spectrum. 
The carbon dioxide exclude mask includes two regions: 
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 Action Result 

3  Click Edit on the Spectral Include/Exclude 
Masks dialog box. 

The Exclude Mask Settings dialog opens: 

 

4  Click Add. Type in “Carbon Monoxide”, then 
click outside the text box. 

A text box appears under Available Exclude Mask Settings, which allows for entering “Carbon Monoxide”: 
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 Action Result 

5  With Carbon Monoxide selected in the list of 
Available Exclude Mask Settings, click Add 
under the list of Exclude Regions or click 
under Low Range. Type in low and high range 
values (2050 and 2240). 

A text box appears under Exclude Regions that allows for entering the Low Range and High Range 
values: 

 

6  TIPS: Alternatively, you can manually set exclude ranges using the Exclude Range Bar and clicking and 
dragging to select regions. See the section above on How to Search Spectral Databases Using a Limited 
Range in a Spectrum. Manually setting the exclude range works in the same way as manually setting the 
include range. 

7  Click OK The Exclude Mask Settings dialog box closes, and the new carbon monoxide mask is added to the list of 
Exclude Masks. 
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 Action Result 

8  Select the new Carbon Monoxide mask, then 
click OK to close the Spectral 
Include/Exclude Masks dialog box. 

The dialog box closes, and the search spectrum is displayed with the newly defined exclude region: 

 

9  Click Search. The search results are automatically displayed in the MineIt application as a hit list.  
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Searching   

How to Subtract One Spectrum from Another 

 
Purpose 
 
This exercise demonstrates how to use the spectral subtraction feature in the KnowItAll Informatics System.  
 

Objectives 

 
This exercise will teach you: 

➢ How to use the spectral subtraction feature in KnowItAll 
 

Background 

 
You can use the ProcessIt applications to perform a point-by-point subtraction of one spectrum from 
another. This capability is useful when analyzing mixtures or composite spectra. 

 
 
 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\
Mixture Analysis\IR Examples 

• Unknown Mixture 01011969.jdx  

KnowItAll Applications Used 

• SearchIt 

• MineIt 

• ProcessIt  
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Set up a spectral search against a mixture 

 Action Result 

1  In the SearchIt application, navigate to 
“C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples\Mixture 
Analysis\IR Examples” and open Unknown 
Mixture 01011969.jdx.  

Limit the database search to Multi-
Technique Sadtler Demo Database – 
Wiley from “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Sample” folder 
by using the Open by browsing button.  

The FTIR spectrum is opened in SearchIt and the DEMOX database is selected for searching: 

 

2  Click Search. Results are displayed in the MineIt application. The first hit is cyclohexane. Both spectra, the query and the 
first hit are displayed in the spectral pane.  
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Create a difference spectrum 

 Action Result 

1 With the hit list displayed in MineIt and the 
first record selected, click ProcessIt in the 
Transfer to bar.  

The Import of Multiple Spectra dialog box opens.  

 

Both the query spectrum and the first hit are displayed.  

2 

 

Click Select All, then click OK on the Import 
of Multiple Spectra dialog box. 

Click Stack Spectra view.  

 

Both spectra–the mixture and the first hit, cyclohexane–are transferred to the ProcessIt IR application:  

 

NOTE: Use spectrum toolbar buttons to adjust the display. The Stacked display is preferable to Offset or 
Overlay for spectral subtraction. 
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 Action Result 

3 Choose Process > Add/Subtract 
Spectrum.  

 

NOTE: You can also use the toolbar button 

. The command is not available unless 
two or more spectra are open.  

The Add/Subtract dialog box opens. The active spectrum is assumed to be the reference spectrum: 

 

4 Make sure the mixture spectrum is the 
Experimental Spectrum, and cyclohexane 
is the Reference Spectrum. If needed, 
change these assignments using either of 
the drop-down lists. Click Preview. 

A preview of the difference spectrum is provided: 
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 Action Result 

5 On the Add/Subtract dialog box, adjust 
Factor to ~0.7. Click Replace. 

A message box opens and asks whether negative values should be truncated to zero: 

 

6 Click Yes.  The mixture spectrum is replaced by a difference spectrum:  
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Repeat the search using the difference spectrum 

 Action Result 

1  Click SearchIt in the Transfer to bar. 

 

 

The Import of Multiple Spectra dialog box opens. 

 

2  De-select DEMOX #12 Cyclohexane so that 
only the difference spectrum is selected. 
Click OK. 

A message box opens: 
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 Action Result 

3  Click Start a new search.  The difference spectrum is loaded in SearchIt: 

 

4  Click User-Select tab and make sure the 
Multi-Technique Sadtler Demo Database - 
Wiley is selected for searching. 

Click Search. 

Results are displayed in the MineIt application. The first hit is benzene, the other component of the 
mixture. 
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Searching   

How to Perform a Structure Search 

 
Purpose 
 
This exercise demonstrates how to perform a structure search using the SearchIt application.   

 

Objectives 

 
This exercise will teach you: 

➢ How to perform an exact match structure search 

➢ How to perform a substructure search 

 

Background 

 
In the SearchIt application, scientists can use a structure fragment as a search term to locate 
chemical structures containing that structural skeleton. This capability is useful for retrieving 
structure fragments because a substructure search always analyzes the entire molecular structure 
of a compound–not just the largest fragment. 

 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\Str
uctures 

• tryptophan.dsf 

• benzenethiol.dsf  

KnowItAll Applications Used 

• SearchIt 

• MineIt 

• ChemWindow®  
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Configure an exact structure match search 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already 
open, click the SearchIt Close button  
to close the current search. 

The SearchIt application’s User-Select tab is displayed and the Selected for Searching list displays the 
databases last used: 

 

2  If databases are already selected for 
searching, click Remove All to clear the 
selections.  

If databases are already selected for searching, click Remove All to clear the selections: 
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 Action Result 

3  Set Limit to Spectral Technique to MS 
(GC). 

Only databases with MS spectral data are displayed: 

 

4  Select database MS – NIST EPA NIH Mass 
Spectral Library xxxx – Main Library for 
searching.  

 

xxxx is the year of the library 

The selected database is added to the Selected for Searching window: 

 

5  Click Structure under Search Categories. The Structure Search dialog is displayed: 
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 Action Result 

6  Click Open file… button. 

Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\ 
Samples\Structures” and select 
Acetylfentanyl.cdx. 

Note: You can also click Draw/Edit to create 
a structure using the ChemWindow 
application. 

The structure is displayed in the Structure tab:  
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Perform an exact structure match search 

 Action Result 

1  Select Exact Match under Search Mode, 
then click Search. 

Exact matches are displayed in the MineIt application:  
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Configure and perform a substructure search 

 Action Result 

1  Click the KnowItAll Back button to return to 
SearchIt. 

 

If you are not on the Structure tab, click to 
resume a structure search. 

The Structure search dialog is displayed: 

 

2  Select Substructure Search, then click 
Search. Click through the records to search 
results. 

 

NOTE: Rather than finding only exact matches 
for the search structure, the substructure 
search returns records that contain the query 
structure as a part of the database structure. 

The substructure search produces more hits than the exact match search. The substructure is highlighted in 
blue and additional fragments are displayed using black coloration:  

 
Note that the original hit list is still available and can be accessed by clicking the appropriate tab (at the 
lower left corner). 
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Configure and perform a similarity search 

 Action Result 

1  Click the KnowItAll Back button to return to 
SearchIt. 

 

The SearchIt Structure search dialog is displayed: 

 

2  Click the Similarity Search radio button. Use 
the default scoring method, Tanimoto. 

Tanimoto is selected for the Search Mode: 

 

3  Click Search. Structure which are similar to the searched structure are displayed in the MineIt application: 
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Searching 
All Compounds and Pure Compounds Database Selections 

 
Purpose 
 
This exercise demonstrates how to use the All Compounds and Pure Compounds Database Selections 

  

Objectives 

 
This exercise will teach you: 

➢ How to use All Compounds and Pure Compounds Database Selections 

➢ How to interpret the search result 

 

Background 

 
All Compounds and Pure Compounds database selections link data by structure, name, InChI, 

CAS Registry Number or synonym. 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\IR 

• Acetonitrile.jdx 

KnowItAll Applications Used 

• SearchIt  

• MineIt 
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Configure and perform an All Compounds search 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already open, 
click the SearchIt Close button  to close 
the current search. 

The SearchIt application’s User-Select tab is displayed and the Selected for Searching list displays 
the databases last used: 

 

2  Click Spectrum under Search Categories. 
Navigate to C:\Users\Public\Public 
Documents\Wiley\KnowItAll\ Samples\IR” and 
select acetonitrile.jdx. 

The spectrum for acetonitrile is displayed: 

 

3  Select the All Compounds option under 
Search Databases. 

The All Compounds search option is selected. 
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 Action Result 

4  Click Search. The search is performed, and results are displayed in the MineIt application: 

 
Compared to the User-Select database search, you will see additional information related to the hit: 

• Replicates are displayed in the upper-left panel. They do not participate in this search and 
navigating through them does not change the value of HQI (Hit Quality Index). The bold ID 
signifies the hit spectrum. 

• Other spectrum information related to the hit compound is displayed in tabs under the spectrum 
pane. 

5  TIPS: • User-Select – User selects which databases to search. This is where you can include user 
databases in a search. 

• All Compounds – All licensed reference databases. Records are linked by structure, name, 
InChI, CAS Registry Number or synonym. 

• Pure Compounds – All Compounds with the exclusion of commercial compounds.  
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Searching   

How to Perform a Multi-Technique Spectral Search 

 
Purpose 
 
This exercise demonstrates how to perform a multi-technique spectral search using the KnowItAll Informatics System.  

 

Objectives 

 
This exercise will teach you: 

➢ How to configure a multi-technique spectral search 

➢ How to analyze the results of a multi-technique search 

 

Background 

 
A multi-technique spectral search permits the optimization of chemical similarity based on several 
analytical techniques to maximize the chemical knowledge obtained on the unknown compound. 

Training Files Used in This Lesson 

C:\Users\Public\Documents\Wiley\KnowItAll\Samples\Si
multaneous Multi-Technique Searching folder 

• Unknown D IR.jdx  

• Unknown D Raman.jdx  

KnowItAll Applications Used 

• SearchIt  

• MineIt 
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Configure and perform a multi-technique spectral search with the User-Select Search Databases 

option  

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already open, 
click the SearchIt Close button  to close 
the current search. 

The SearchIt application’s User-Select tab is displayed, and the Selected for Searching list displays the 
databases last used: 

   

2  Select User-Select under Search Databases 
option. If databases are already selected for 
searching, click Remove All to clear the 
selections 

The Selected for Searching databases section is cleared: 

 

3  Using the Limit to spectral technique tab, 
select IR then click Add All. Repeat for Raman. 

All of the available IR and Raman databases are added to the Selected for Searching window: 
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 Action Result 

4  Click Spectrum under Search Categories. 

Navigate to “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples 
\Simultaneous Multi-Technique Searching”. 

Open Unknown D IR.jdx. 

An IR spectrum is displayed in the SearchIt spectrum window: 

 

5  Click Spectrum under Search Categories to 
add another spectrum. 

From the folder “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples 
\Simultaneous Multi-Technique Searching”, 
choose Unknown D Raman.jdx. 

The Raman spectrum is added to the search: 
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 Action Result 

6  Click Search. The search results are displayed in the MineIt application:  

 

Because this was a multi-technique search, the Database pane’s Plot tab automatically displays a scatter 
plot representing HQI values for the two spectral techniques. The point with the highest HQI values is 
selected at the upper right. You can click on the dots in the plot to view the different search results, or 
click Table tab to view tabular results. 
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Configure and perform a multi-technique spectral search with the All Compounds Search 

Databases option 

 Action Result 

1  Do one of the following: 

• If the SearchIt application is not open, 
navigate to the Data toolbox and click its 
icon. 

 

• If the SearchIt application is already open, 
click the SearchIt Close button  to close 
the current search. 

The SearchIt application’s User-Select tab is displayed, and the Selected for Searching list displays the 
databases last used:  

   

2  Click Spectrum under Search Categories. 
Navigate to C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples 
\Simultaneous Multi-Technique Searching” and 
select Unknown D IR.jdx. 

The spectrum is displayed in the SearchIt application: 
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 Action Result 

3  Click Spectrum under Search Categories to 
add another spectrum. 

From the folder “C:\Users\Public\Public 
Documents\Wiley\KnowItAll\Samples 
\Simultaneous Multi-Technique Searching”, 
choose Unknown D Raman.jdx. 

The Raman spectrum is added to the search: 

 

4  Check All Compounds under Search 
Databases option. 

All Compounds search is selected under Search Databases: 

 

  



  

108658-2REV20241009 Copyright ©2024 by John Wiley & Sons, Inc. All rights reserved.  

KnowItAll Training   Searching IR and Raman - 72 

 Action Result 

5  Click Search.  The search results are displayed in the MineIt application:  

 

Because this was a multi-technique search, the Database pane’s Plot tab automatically displays a 
scatter plot representing HQI values for the two spectral techniques. The point with the highest HQI 
values is selected at the upper right.  
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 Action Result 

6  Examine the example shown in the Results. 
Compare the scatter plot of the User-Select 
database search and that of All Compounds 
search. 

 

 
 
 

User-Selected database search: 

 

All Compounds database search: 

 

They are more ppints near the circled region including the circled points. 
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 Action Result 

7  Using the search results from Step 5, examine 
the circled points. 

These two records are the stereoisomers whose IR and Raman spectral records are linked not by 
structure, but by other features in the record (name, InChI, CAS Registry Number or synonym). 

(S) Isomer: 

 

(R) Isomer: 

 

 


